De Creatieve \WIJZE BEZIGHEDEN
STEM - INGEGNO.BE | VOORWIIZE KINDEREN #STEM-ccodemie

Handleiding Inkscape

Intro:

Inkscape is een gratis ( open source) tekenprogramma waarmee
vector-tekeningen gemaakt kunnen worden. Men kan hierin ook
vertrekken van een afbeelding (.JPG, .PNG, etc.), om deze dan om
INKSCAPE te zetten tot een vector bestand.

https://inkscape.org/nl/download/
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https://inkscape.org/nl/download/

Wat is een vector tekening?

Men kan 2 type digitale afbeelding onderscheiden:
. Raster afbeelding (Bitmap - pixels)
. Vector tekening

Een vector bestand is een grafische afbeelding die opgebouwd is uit vector informatie. Dit
kan bestaan uit vele individuele objecten, opgebouwd uit lijnen, curves en vormen,
aangevuld met kleuren, patronen en effecten.

Waarom?

1. Verschaling:
Vectortekeningen kan men oneindig gaan verschalen zonder iets van kwaliteit te

verliezen. Het heeft als extra voordeel dat de bestand-grootte klein blijft.

2. Lasercutting: Snijden, Graven, Rasteren
Voor het uitsnijden of graveren van een figuur moet de
lasercutter een duidelijk gedefinieerd pad kunnen
volgen. Dit is enkel mogelijk via een vectorbestand.

Indien men toch een rasterafbeelding inlaadt, of bij een
vectorbestand met verkeerde instellingen (lijnkleur, lijndikte)
dan zal de software dit inlezen als een raster opdracht. —
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Klaarmaken voor Lasercutter

LET OP: Afhankelijk van het type Lasercutter & gekoppelde software zullen andere
instellingen moeten gebruikt worden om de gewenste output te krijgen. Toch werken ze
allemaal op hetzelfde principe: “Kleurcode”. Rasteren werkt normaal gezien altijd op
dezelfde manier: met (opgevulde) vlakken of zwart-wit foto’s.

Locatie @ Ingegno (Drongen)

Type Laser Cutter Full Spectrum Laser
H-Series 5the Gen Desktop

Vermogen 40/45 Watt

Besturingssoftware | Retina Engrave

SETTINGS Lijnkleur

Snijden MAX ROOD ( 255,0,0) uit

Graveren MAX BLAUW (0,0,255) uit

Extra Settings MAX , , , uit
Magenta etc. (...,255,...)

Rasteren / Zwart / Grijstinten
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In Inkscape

Snijden of Graveren

[FFill and Stroke (Shift+Ctrl+F) 5 @ | [AFill and stroke (Shift+Curl+ 9 ® | [AFill and Stroke (Shift+Crl 5 6| LAFill and Stroke (Shift+Cul+F) & ®
| —m—" [ —— T [r——————
Fill | [ Stroke paint | = Stroke style Fill | [ Stroke paint | =fstroke style Fill | T swoke paint | 2§ Stroke style Fill | T Stroke paint = stroke style
xBOOBEO? ow <Boom ? *xO00BE | ? width: (0.025]  ° |mm ¥
No paint Flat color Flat coler s
son: [ R (R
RGE HSL || CMYK heel CMS. RCE HiL CMYE | Wheel CMs
- Miter limit: 4.00
R = R 0
G = c: o 7 <o 'm A M
B - B: 255 Dashes: ———————v  0.00
. e A > .|| e = - -
B0 / RCEA:| 0000 -4 RGBA' | 0000
Blur (%) 0.0 21 glur (%) 00 ~ || Blur %) 00 Z|| | sur (%) 00 *
Opacity (%) 100.0 Bl opaciy (%) 100.0 [l Opacity (%) 100.0 [l o pacity (%) 10008

Lijnkleur uit Vulling in Zwart of Grijstinten (0,0,0)

#Vulling en lijn (Shift+Ctrl+F) = ® [FVulling en lijn (Shift+Ctrl+F) = @®

Vulling I Lijnkleur = Lijngtijl Vulling [ Lijnkleur = Lijnstijl

-

xOOOEO?

Geen opvulling .
S
o H
o B
55
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Inkscape Gebruiken

B Ve document L - Inocang, R _ses . s T e |
File Edit Yww Layer Object Path Tet Filery Edensicens Help
B A S BB R x| zeesl v el wsael a ok mErelim o] AMex = 'n
@, o For B B SRS
i 2 Eill [ Stroke paint | =Stroke stybe =] -
- x@oomag? o @
[-l ;; Flat colour = _4
L |reB| HsL |cMvic] whee| cus I
o : : I > | o
e r 5
i :
¥ - - *
3 - & ¥ _
¥ 7| };
A #
N - il ?
& 3 Y - ] RGEA | DOAODETE o /
E E_- Blur G |
S i 8] 0w E e
e Qpacity (%) a '
B, Owoz @ g
z T ()
: ,
0: 100 | % & +Layeri | = | Recltangle in layer Layer 1. Click selection fo toggle sc.alm'ruabqnhandlzi Eg: ;: AR

-
 C—

1. Belangrijkste Functies

File Ed

——— Nieuwe pagina

Lijnen aanpassen

| ou
[ B [

Standaard figuren

OfL0POCOoOPA =

y\i

Tekenlijnen (met de vrije hand)

Rechte & kromme lijnen (viceiend)

e - Tekst & lettertypes

Object selecteren, verplaatsen, vervormen/verschalen
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2. Standaardeenheid aanpassen

Ga naar Bestand > documenteigenschappen > pagina > Standaardeenheid in mm
(File> Document Properties > Page > Default Unit in mm)

|li‘: Documenteigenschappen (Shift+Ctrl+D) @ ®

Pagina Hulplijnen Rasters Kleven Kleur Scripting Metadata Licentie

Algemeen
Standaardeenheid: |mm |~ |

3. Aanpassen blad grootte

Het is handig om je pagina grootte aan te passen aan het formaat van je materiaal dat je in
de lasercutter steekt. Zo ben je zeker dat je tekening niet groter is dan je plaat materiaal.

- Bestand > documenteigenschappen > pagina > Oriéntatie > Breedte en Hoogte
COriéntatie: () Staand @ Liggend

Eenheden: !EEI

Aangepaste grooth
Breedte: |500,00000

KICEED

Hoogte: : 300/00000

Pagina schalen naar inhoud...

4. Pagina-grootte aanpassen aan selectie

Wanneer je klaar bent met de tekening kan je ook alles selecteren en je pagina-grootte
aanpassen aan je selectie.

- Bestand > documenteigenschappen > pagina > ori€ntatie > + pagina aanpassen aan

inhoud > pagina schalen naar tekening of selectie
Oriéntatie: (D Staand @ Liggend

-Aangepaste groott

Breedte: |500,00000 ,LA: Eenheden: gmm B
Hoogte: | 300,00000 :

[=l Pagina schalen naar inhoud...

[ -
Bovenmarge | 1,00000 H

y P | =
Links: | 1,00000 =l Rechts: | 1,00000
Onder. |1,00000 B

Pagina schalen naar tekening of selectie |

1%
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Blad naar BOVEN of BENEDEN

Scroll (muis)

Blad naar LINKS of RECHTS

_JShift + Scroll (muis)

ZOOM crl

+ Scroll
Knippen ctrl

+ X
Kopiéren ctrl

+C
Plakken ctrl

+V

in verhouding tekenen of verschalen

Ctrl

+ @ inhouden + verslepen

verspring je van huidige functie naar

muiscursor k (en terug)

Space

(spatie)

“Klik” = linkermuisknop snel induwen en loslaten
“Verslepen”= Linkermuisknop inhouden, muis verplaatsen & later los laten
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7. Lijnen Tekenen ( Bezier tool)

tutorial1 (engels): https://www.youtube.com/watch?v=AAgWhnf_p3k
tutorial2 (engels): https://www.youtube.com/watch?v=uymedeE3mJE

7.1 Rechte Lijnen:

(Korte uitleg: pad tekenen door hoekpunten aan te klikken. Toets enter op het eind)

1. Klik op delié’icoon

2. Startpunt: Linkermuisknop @ “Klik”
Belangrijk: Muisknop loslaten!

S e
AN L e e L

S
Tl

3. verplaats je muis naar nieuw punt

s
Ly el

4. Linkermuisknop: “Klik” (en loslaten)

5. Doe zo verder tot...

som
P

6. Eindpunt: “Klik” en “Enter” lJ—(J/—
(Het pad wordt duidelijk zichtbaar)

=)
A |

I AHQLOLPOP REQSOL20H0

7.2 Kromme Lijnen of curve:

Methode 1 -Vertrek van rechte lijnen
(Korte uitleg: Rechte lijnen krom maken door op de lijn de muis te verslepen)

1. Kklik op ’I‘Fc = paden aanpassen

__________ N
2. Plaatst je muiscursor op een lijn :
3. Linkermuisknop aanklikken +
inhouden !
| O
B

4. Sleep je muis verder weg
De lijn beweegt nu als een
elastiekje

SOPLECObA
T P T T e vl e

[=R=1 0
i I
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https://www.youtube.com/watch?v=AAgWhnf_p3k
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6. Laat de muisknop los wanneer je lijn
de gewenste kromming maakt.
Fijnere aanpassingen: (via de Bezier handvaten)

e
1. bliffin =¥

2. De bezier handvaten worden zichtbaar door op dit & icoontje te klikken.

T 2| FEnmn | Vel |l | x|semed vsssandm V| £ £ 8| il O

* g||||||;p||||||||?Fll|||||'|‘II:.:'||I|I||||‘P;|||||||||‘F)||I|I|I||‘?;|||||||||2I:.)||I||||||2P;|||||||||2F‘)|||||||||2'I7;|||||||||3M|I|I|I
2

e

)

3. Klik op een punt van de curve

die je wil aanpassen X -
£
4. Plaats je muiscursor op een % ]
bolletje (eindpunt) van de E .
hulplijn of ookwel het handvat ~ © ]
Q? %
©
5. linkermuisknop inhouden en gﬁg?:
muis verslepen &
Al
6. Laat de muisknop los wanneer & |

het de gewenste curve krijgt.

Methode 2 : Teken direct kromme lijnen (Moeilijker te besturen)

1. Klik op deﬁ'icoon

£ ]
2. Startpunt: Linkermuisknop “KIik” %
©r
3. Verplaats je muis naar een nieuw punt g? ]
oF

4. Linkermuisknop induwen + g% b
inhouden Y _
A
5. Versleep de muis Lk

Nu wordt meteen een kromme
getekend
De blauwe lijn is een hulplijn

6. Laatlos wanneer je de gewenste kromme krijgt.

7. Teken zo verder... Linkermuisknop Inhouden > Verslepen > loslaten
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8. Toets Enter om de lijn definitief te maken.

N

9. Om de getekende curve nadien aan te passen , maak opnieuw gebruik van

8. Vulling, Lijnkleur, Lijndikte

Ga naar Object > Vulling en lijn...
(Object > Fill and Stroke)
Q *Mieuw document 1 - Inkscape
Bestand Bewerken Beeld Laag gbject Paden Tekst Filters Uitbreidingen Help

B @ | & 4 < (D Valingen .. (ShSCHIERN} ©: (0000
P a5 ap cH Objecteigenschappen... Shift+Ctrl+ O L ]
Rk f| @ Symbolen... Shift+ Ctrl+Y

9. Afbeeldlng Invoegen (Via internet » Google Afbeeldingen / Pinterest / Site...)

Methode 1: Kopiéren & Plakken

1. Rechter muisklik op afbeelding van internet > Afbeelding kopiéren (Copy)
2. Keer terug naar Inkscape
3. In tekenblad Rechtermuisklik > plakken (paste) of “CTRL +V”
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Probleem met achtergrond?
een transparante achtergrond (PNG-afbeelding) wordt zwart in inkscape

Internet in Inkscape

Methode 2: Afbeelding opslaan & Importeren
1. Rechter muisklik op afbeelding van internet > Afbeelding opslaan als (save as)

2. Sla de afbeelding op in een map ( vb. downloads) met en pas de naam eventueel
aan

Keer terug naar Inkscape
4. Ga naar bestand > Importeren > zoek je opgeslagen afbeelding> open

w

10. Afbeelding Doorzichtig / Transparant maken

= Dit maakt het gemakkelijker en duidelijker als men de lijnen wil overtekenen

1. Selecteer de afbeelding door het aan te klikken
2. Maak het venster “Vulling & Lijn” zichtbaar via Object > vulling en lijnen
(fill and stroke)

@ *Nieuw document 1 - Inkscape
Bestand Bewerken Beeld Laag Object Paden Tekst Filters Uitbreidingen Help

ﬁ % Vulling en lijn... Shift+ Ctrl+F B: |opoD 2

| R e TUR e Tl i TR cid Objecteigenschappen... a2 4
k A Symbolen... Shift+Ctrl+Y

3. Verander de ondoorzichtigheid van 100% naar bijvoorbeeld 50%
Dit kan door de balk met je muis te verschuiven of een waarde in te vullen (rechts)
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AVulling en lijn (Shift+Ctrl+F) = @ [ Vulling en lijn (Shift+Ctrl+F)
Vulling [ Lijnkleur =t Lijnstijl Vulling [ Lijnkleur = Lijnstijl
xBOOEO? oF xOOOEQ?
Vulling is niet gedefinieerd Vulling is niet gedefinieerd
Vervagen (%) 0oe Vervagen (%)
Ondoorzichtigheid () h[!},d : Ondoorzichtigheid (%) |

00l
50,0
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11. Afbeelding Automatisch Vectoriseren

tips: - Kies een duidelijke afbeelding (hoge resolutie)
- Een afbeelding in één kleur of “zwart-wit” werkt het best

1. Selecteer je afbeelding

2. Ganaar Paden > Bitmap overtrekken @ Eitmap overtreldken (Shifts AltE)

(path > Trace Bitmap) (&' Bitmap overtrekken (Shift+Alt+B)
3. Nadien kan je gaan spelen met de Modus Opties Met dank aan

verschillende opties: ket scaec ruakct Eea padk
_ Grenswaarde Helderheid @) Grenswaarde helderheid Grenswaarde: | 0,450 =]
- Randherkenning (Voorkeur) () Randherkenning Grenswaarde: | 0,650 -
- K/eurmeﬁng () Kleurmeting Kleuren: |6 =
4. Klik op “oke” en sluit het paneel [ Kleuren inverteren

Meerdere scans: een groep van paden maken

5. Zet de vullen uit en lijnkleur aan O Helderheidsstappen Huean= 8.

(voor lasersnijden of graveren) O Kewr

8 Grijswaarden

6. De originele foto |Igt nu nog onder het Vervagen Scans stapelen [] Achtergrond verwijderen

gemaakte pad.

Scheidt ze van elkaar door met de pijl k op de afbeelding te staan
Linkermuisknop inhouden > verslepen > loslaten

Probleem: De vectortekening is momenteel één geheel. Men kan nog geen lijnen
afzonderlijk aanpassen, of verwijderen. Via volgende stappen wordt de tekening
onderverdeeld per gesloten pad.
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12. Vector Tekening Opdelen in afzonderlijke paden

1.
2.

Selecteer de vector tekening door het met de pijl k aan te klikken
Ga naar paden > opdelen
of ( Shift+ Ctrl + K)

13. TEKST invoegen

1.

2.

Klik op het A-[icoon.

Klik ergens op het blad (waar je de tekst ongeveer wilt) en typ je gewenste tekst uit.

Met de k functie kan je uw tekst nadien nog verplaatsen of verschalen.
(Houd de Shift-toets ingedrukt tijdens het verschalen.)

Lettertype en lettergrootte kan aangepast worden in de linker bovenhoek.

Bestand Bewerken Beeld Laag Object Paden Tekst Filters Uithreidingen Help
:Vsans-serif B B | 32 .Vs:i‘durmal =] D D D wv; | x X, | = 1,25 |e| Aa ;O,DB ’-:‘ "ﬂi-ﬁ,m ’3 aa -0.00 -.‘:
*u.\m.\.\-am...\-m.‘kl-m...0.\..Im.\.\lm.\.\lm.\.\Inm...\Ism....lsm....
a
!\
£ ~ Halllo
: Hallo
0
Q!

Om door te laseren of te graveren zetten we opnieuw de vulling uit
en lijnkleur op Rood of Blauw. ( Zie p.3)

Kies als laatste bewerking om je tekst om te vormen tot een pad:
Ga naar Paden > Object naar pad
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LET OP: Wanneer je tekst wil uitsnijden zal ook het binnenste gedeelte uit vallen

abdegopq
abdegoeonpy

Daarvoor bestaan er dan speciale lettertypes “FabFonts” waarbij tussenschotjes voorzien
zijn zodat de binnenste delen blijven staan.

Allerta Stencil Regular
CasuvalStencil
CHAPLONE
CILLEANWORK
sultQutsFLF
Gunplay

HFJLI_FJI\IIJFJL/- ST/'NG/L
KNOW YOUR PRODUCT

LIN'T'SEEC
OCTIN PRISON FREE
SansrleinCut

SchabLonski

http://ingegno.be/lasercutter-lasersnijder-fonts/

14. Interessante Links

Inkscape tutorial: Basic
https://inkscape.org/nl/doc/basic/tutorial-basic.nl.html

handleiding Inkscape voor Lasercutter:
http://www.cutlasercut.com/resources/drawing-quidelines/styles-examples

Lesjes Inkscape:
https://sites.google.com/site/henniekoops/lesjesinkscape

Image Trace:
https://www.youtube.com/watch?v=n_DrgXkw0OBo

NS
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http://ingegno.be/lasercutter-lasersnijder-fonts/
https://inkscape.org/nl/doc/basic/tutorial-basic.nl.html
http://www.cutlasercut.com/resources/drawing-guidelines/styles-examples
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